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Installation Guide
1 Directory structure of the CD-ROM
The CD-ROM contains all the files needed to install the ARM Developer Suite (ADS) version 1.0.1 onto a 
UNIX workstation. The CD-ROM conforms to ISO9660 Level 1 standard. It contains the following directories 
and files:

Installation scripts 

install.sh Installs all or part of the product from the CD.

usrsetup.sh Sets up the environment variables after installation. There are 
also three support files for this script:

• env.ads.xxx.csh

• env.ads.xxx.sh

• qdsptype.csh

setports.sh Sets permissions on the ports to enable remote debugging.

armdtins.csh Installs DynaText documentation browser (called by 
install.sh).

Common files for UNIX 

common Contains the common files required for all UNIX installations:

angel.tar Angel debug monitor in binary form, for 
downloading to a target board.

angelsrc.tar Rebuild kit for the Angel debug monitor.

bin.tar The binary code.

armfpa.tar The ARM FPA support code.

examples.tar Example programs that demonstrate how to write 
code for the ARM family of processors.

html.tar Documentation for the RogueWave C++ libraries.

include.tar C and C++ header files for the C and C++ libraries.

lib.tar Linkable C and C++ libraries.

onlinbks.tar ADS documentation as online books, to be read by 
DynaText browser.

pdf.tar ADS documentation as PDF files, to be read by 
Adobe Acrobat reader.
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dtext41.tar 

Contains the DynaText documentation browser.

apps_lib Contains the ARM Applications Library source code.

Host-specific files for UNIX 

hpux Contains the PA-RISC HP-UX 10.20 hosting, including:

acroread.tar Adobe Acrobat Reader version 4.0.

armsd.tar Rebuild kit for the armsd command-line debugger. 

bin.tar ADS executables.

source.tar Rebuild kit for the ARMulator for use with the ADU 
graphical debugger.

windu.tar Runtime support files used by the GUI tools in 
ADS.

solaris Contains the Sun Solaris hosting. The file names are the same as for HP-UX.

License management 

licenses Contains license management files.

flexlm Contains license management tools for Solaris and HP-UX.

license.txt Is the text of the ADS license agreement.

licreq.txt Is a form to use for requesting a permanent license.
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2 Installing ARM Developer Suite (ADS) 1.0.1
The following sections describe how to install ADS 1.0.1:

• on a Sun workstation

• on an HP workstation.

2.1 Installing on a Sun workstation
This section describes how to install ADS 1.0.1 on a Sun SPARC workstation.

Hardware requirements

The following are the minimum hardware requirements for installing and running ADS 1.0.1:

• Sun SPARC compatible machine.

• 87 MB of disk space (for a Compact install).

• CD-ROM drive. This can be a networked CD-ROM drive.

• CDE environment is required for correct operation of AXD and ADU.

• AXD and ADU are optimized for operation on UltraSPARC machines.

Software requirements

You must have one of the following operating systems to install and run ADS 1.0.1:

• Solaris 2.5.1

• Solaris 2.6

• Solaris 7

Installing ADS 1.0.1

You should remove any previous versions of ADS before installing this version. In addition, we recommend 
that you remove any previous versions of the ARM Software Development Toolkit (SDT). 

To install ADS 1.0.1:

1. Insert the CD into the CD-ROM drive.

2. Become superuser:

a. Type su at the shell prompt.

b. Enter the root password for your machine:

Password: root_password

3. Type volcheck to mount the CD.
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4. Exit superuser mode:

exit

5. Move to the top-level CD-ROM directory:

cd /cdrom/ads101

6. Run the install script:

sh install.sh

7. Follow the install script prompts to install ADS.

8. Source your .cshrc file:

source .cshrc

or, if you have created a separate ads.cshrc file:

source ads.cshrc

9. Follow the instructions in Installing the software license on page 6 to install a temporary license.

Note
 Important additional information about this release is contained in a readme.txt file in your ADS 
installation directory.

2.2 Installing on an HP workstation
This section describes how to install ADS 1.0.1 on an HP machine.

Hardware requirements

The following are the minimum hardware requirements for installing and running ADS 1.0.1:

• HP series 9000 model 7xx.

• 87 MB of disk space (for a Compact install).

• CD-ROM drive. This can be a networked CD-ROM drive.

Software requirements

You must have HP-UX 10.20 or later to install and run ADS.
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Installing ADS 1.0.1

You should remove any previous versions of ADS before installing this version. In addition, we recommend 
that you remove any previous versions of the ARM Software Development Toolkit (SDT). 

To install ADS:

1. Insert the CD into the CD-ROM drive.

2. Become superuser:

a. Type su at the shell prompt.

b. Enter the root password for your machine:

Password: root_password

3. Type the following at the shell prompt to mount the CD-ROM:

mount -r -F cdfs -o cdcase cdrom-device /cdrom

For example:

mount -r -F cdfs -o cdcase /dev/dsk/c1t2d0 /cdrom

4. Exit superuser mode:

exit

5. Move to the top level CD-ROM directory:

cd /cdrom

6. Run the install script:

sh install.sh

7. Follow the prompts to install ADU.

8. Source your .cshrc file:

source .cshrc

or, if you have created a separate ads.cshrc file:

source ads.cshrc

9. Follow the instructions in Installing the software license on page 6 to install a temporary license.

Note
 Important additional information about this release is contained in a readme.txt file in your ADS 
installation directory.
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2.3 Installing the software license
You need a license file to run ADS 1.0.1 components. The ARM licensed software is license-managed using 
the FLEXlm license manager. This prevents you from running ADS until you have obtained a valid license 
file from ARM Limited.

Installing a temporary license

ADS finds the license file from the contents of the environment variable ARMHOME. Ensure that ARMHOME 
points to the full pathname of the top-level directory where you installed ADS 1.0.1 (the usrsetup.sh script 
sets this variable). This directory contains a subdirectory called licenses.

To install a temporary license:

1. Install ADS on the client machine.

2. Change directory to the $ARMHOME/licenses directory.

3. Execute the lmutil program:

lmutil lminstall

You are prompted to enter the path to output license file.

4. Press the Return key to accept the default filename. The default filename is based on the current date.

5. Enter your temporary license number.

Your temporary license is printed on a label that is stuck to the box containing the ARM Developer Suite 
software. The label contains a license number of the form:

armlmd-ads-xxxxx-xxxxx-xxxxx-xxxxx-xxxxx-xxxxx-xxxx

where each x represents a number.

Type the temporary license number into the entry field, exactly as it appears on the box. Do not add any 
extra spaces, and include the minus (-) characters.

6. Press the Return key. If the license code is valid, the message Good is displayed.

7. Press the Return key twice. The data has now been converted into a readable license and saved to 
disk.

The temporary license lasts for a maximum of 45 days. To get a full license, follow the instructions in 
Installing a permanent license.

Installing a permanent license

Contact your system administrator to obtain a permanent license. The administrator must fill in the license 
application form license_request_form.txt in the ADS installation directory, then email or fax the file 
to ARM Limited. A permanent license will be returned. The administrator must install the permanent license 
on the license server.
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For full information on how to install your permanent license file, and how to run the license manager 
software, refer to the ARM Developer Suite Getting Started Guide. Detailed information on FLEXlm is also 
provided in the file enduser.pdf located in the flexlm subdirectory of the installation CD.
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3 Viewing online documentation
ADS provides comprehensive online help. In addition, it provides online versions of the printed manuals in 
both Dynatext and PDF formats.

3.1 Dynatext
The manuals for ADS 1.0.1 are provided as Dynatext electronic books. The books and the Dynatext viewer 
are installed if you selected this option during installation. The manuals are installed by default in a Typical 
or a Full installation.

Viewing the manuals

To display the online documentation ensure that install_directory/dtext41/bin is on your path 
and type dtext at the shell prompt.

3.2 Adobe Acrobat Reader
The manuals for ADS 1.0.1 are provided on the CD-ROM in Acrobat Portable Document Format (PDF) files. 
You must have a copy of Adobe Acrobat Reader installed before you can view them. Acrobat Reader is 
supplied with ADS 1.0.1 and is also available from the Adobe web site http://www.adobe.com.

Viewing the manuals

To view the PDF version of the manuals:

1. Start Adobe Acrobat Reader.

2. Select Open... from the File menu.

3. If you have installed the PDF versions of the online documentation, move to 
install_directory/Pdf.

If you have not installed the PDF files, you can view the files directly from the /Pdf directory on the 
CD-ROM.

4. Open the PDF files you want to view.

For more information on using Adobe Acrobat Reader, select Reader Help from the Help menu.
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3.3 HTML
The manuals for the RogueWave C++ library for ADS 1.0.1 are provided on the CD-ROM in HTML files. Use 
your web browser software to view these files.

3.4 Online help
ADS 1.0.1 provides the following online help and context-sensitive help.

Context-sensitive help

Context-sensitive help is available for the GUI components of ADS. With ADS 1.0.1 running, position the 
cursor on any field or button for which you need help and press the F1 key on the keyboard. If relevant online 
help is available, it is displayed. An alternative method of invoking context-sensitive help is to click on the 
arrow/question-mark tool in the toolbar, then click on the field or button for which you need help.

Viewing online help

The Help menu is available in the menu bar when you run any of the ADS GUI components. Click on the 
arrow tool or select Contents from the Help menu to display the main help topics. You can navigate to a 
specific page of help in any one of the following ways:

• From the Contents tab of the Help Topics screen, do any of the following:

— click on a main topic to select it

— double-click on a main topic book to open it (single-clicking toggles status)

— click on the Open button

— click on the Display button.

— click or double-click on a sub-topic.

• From the Index tab of the Help Topics screen, do any of the following:

— type the first few characters of a likely index entry

— scroll down the displayed list of index entries until the entry you want is visible

— click on the required index entry.

• From the Find tab of the Help Topics screen, do any of the following:

— follow the Find Setup Wizard instructions to create a full text search file

— type or select key words that may occur anywhere in the help text

— select a topic from the displayed list of topics that contain the specified words.
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• From any other page of help that has a hypertext link to the page you want, click on the highlighted 
hypertext link.

— highlighted hotspots with text in italics display brief explanations in pop-up boxes

— highlighted hotspots with solid underlining jump to other related pages of help

— browse buttons display related pages of help.
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4 Feedback
This section describes how to report problems and comments on ARM ADS 1.0.1 and its documentation.

4.1 ADS 1.0.1
If you have feedback on ADS 1.0.1, please contact your supplier.

To help us to provide a rapid and useful response, please give:

• details of the release you are using, such as the version number

• details of the platform you are running on, such as your hardware platform, operating system type and 
version

• a small stand-alone sample of code that reproduces the problem

• a clear explanation of what you expected to happen, and what actually happened

• the commands you used (including any command-line options)

• sample output illustrating the problem

• the version string of the tool (including the version number and date).

4.2 Feedback on the documentation
If you have problems with the ADS 1.0.1 documentation, please send email to errata@arm.com giving:

• the document title

• the document number

• the page number(s) to which your comments refer

• a concise explanation of the problem.

General suggestions for additions and improvements are also welcome.
ARM DSI 0010B Copyright © 1999, 2000 ARM Limited. All rights reserved. 11
 


	1 Directory structure of the CD-ROM
	2 Installing ARM Developer Suite (ADS) 1.0.1
	2.1 Installing on a Sun workstation
	2.2 Installing on an HP workstation
	2.3 Installing the software license

	3 Viewing online documentation
	3.1 Dynatext
	3.2 Adobe Acrobat Reader
	3.3 HTML
	3.4 Online help

	4 Feedback
	4.1 ADS 1.0.1
	4.2 Feedback on the documentation


